C.A.T.A. Conference 2010 Class Registration (County Member Rates)

Monday - August 234, 2010

DPT Classes
Property Measurement (Y2 day) **1pm Start** $10.00 [ ]
Outside Providers
Kaplan College — Appraising Green Properties (1/2 Day) **1pm Start** $30.00 [ ]
APEX — Mobile Technology for the Real Estate Professional (1/2 Day) **1pm Start** FREE [ ]
Harry Fuller - USPAP (7 hour update class) Includes Manual **9:00am start** $85.00 []
Tuesday - August 24th, 2010 |
DPT Classes
Personal Property (2 Day) 1° Day ( NO CEH) $20.00 [ Rural Structure Valuation (1 Day) $10.00 [ ]
Statistics (2 Day) 1 Day (Size limited to 18) $20.00 [] Environmental Properties (1 Day) $10.00 [ ]
Outside Providers
Kaplan College - Site Valuation & Cost Approach (2 Day) 1st Day **Tested** $120.00 [ ]
Dick Gilmore (ASFMRA) - Appraising Ag Land in Transition (1 Day) $65.00 [ ]
M. Steven Kane — Appraisal Valuation Modeling $65.00 [ ]
Harry Fuller - USPAP (7 hour update class) Includes Manual $85.00 [ ]
James Canestaro — Evaluating Commercial Construction (2 Day) 1% Day **Test Optional For QE**  $120.00 []
| Wednesday - August 25th, 2010 |
DPT Classes
Personal Property (2-Day) (NO CEH) 2"Day [] Basic Title Conveyance (1 Day) $10.00 [_]
Statistics (2-Day) (Size limited to 18) 2"Day [ Oil and Gas Equipment (1 Day) $10.00 [ ]
Hotel / Motel Valuation (1 Day) $10.00 [] Sales Confirmation (1 Day) $10.00 []
Outside Providers
Kaplan College — Site Valuation & Cost Approach (2 Day) 20dDay [ ]
Deane Wilson (ASA) — Adjustments — The Good, The Bad, and The Ugly (1 Day) $65.00 [ ]
Dick Gilmore (ASFMRA) — Income Approach Applications (1 Day) $65.00 [ ]
Garth Thimgan (IAAO) — Depreciation Analysis (2 Day) 1% Day **Tested** $140.00 [ ]
James G. Felt — Water Law | - Water Rights and Their Valuation (1 Day) $65.00 [ ]
James Canestaro — Evaluating Commercial Construction (2 Day) **Test optional for QE** 2rd Day [ ]
| Thursday - August 26th, 2010 |
DPT Classes
Vacant Land Valuation (1-Day) $10.00 []  Abatements (1/2 Day) $10.00 [_]
Time Trending (1 Day) (Size limited to 18) $10.00 []  Bed & Breakfast (1/2 Day) $10.00 [ ]
Outside Providers
Deane Wilson (ASA) — Going Concern Valuation(1 Day) $65.00 [ ]
IAAO - Depreciation Analysis (2 Day) **Tested** 2rd Day [ ]
Kaplan College — Data Analysis in a Declining Market (1 Day) $65.00 [ ]
James G. Felt — Water Law Il - Water Rights and Their Valuation (1 Day) $65.00 []
James Canestaro — Evaluating Residential Construction (1 Day) $65.00 [ ]
Early Registration Deadline is June 30, 2010
Name: Total All Days | $
Daytime Phone: Conference Fee + $60.00
E-Mail Address: Total Amount Due | $
Do you plan to attend the Wednesday evening dinner meeting? YES [|] NO []
Do you prefer a vegetarian meal? YES [ ]
License Level: Registered [ | Licensed [ | Certified Res [ ] Certified General [ NA [
Field of Expertise: Residential, Commercial, Etc




Your executive board has worked very hard to provide an array of classes that will meet your needs. Our goal
has been, and continues to be, to provide Colorado County appraisal staff with very affordable continuing
education. The CATA conference has grown to over 350 attendees, and it has become an important networking
forum for many of the Assessor’s office staff members.

We continue to contract with alternate providers to expand our educational offerings. These classes taken
outside of the CATA forum would cost 3 to 4 times what we can offer them for. Aside from negotiating a more
affordable fee, we have been fortunate enough to receive a generous grant from the Colorado Assessors
Association that has allowed us to offset our prices. Unfortunately, due to the supplement provided to us by
the CAA, we are unable to give associate members and non-members the credit that results from this
contribution. Please complete the appropriate registration form depending on your status with CATA.
Associate Member and Non-Member registrations are available on the CATA website at www.cata-log.org.
Individuals who paid membership dues by the April 15th deadline, (County employees excluded,) are Associate
members. If you did not pay dues, you are a Non-Member.

Please note the cancellation policy at the bottom of this page.

1. Please submit one registration form per member. One check may be submitted per County to cover all of
those registering. Please make checks payable to: Colorado Association of Tax Appraisers. We prefer
all forms be faxed (followed with payment by mail) to THE CATA TREASURER at:

Mail To: Fax To:
Summit County Assessor Mike Peterson - CATA Treasurer
Attn: Mike Peterson - CATA Treasurer Fax Number: 970-453-3481
PO Box 276

Breckenridge, CO 80424

2. Some class sizes will be limited this year and will be available until full. An e-mail will go out to
everyone with an e-mail address registered at www.cata-log.org when a class is full. Please register.

3. The classes offered by contracted providers do not necessarily pertain to Colorado Law or DPT guidelines
and mandates. They will however, offer a different perspective (fee or otherwise) and broaden your
knowledge as an appraiser. Although we have received high recommendations for each of the providers
and their classes, you take them at your own risk. All classes are approved for continuing education by
the Board of Real Estate Appraisers, unless otherwise noted.

4. The number of hours is designated with the class description by “CEH” for Continuing Education
Hours or “QEH” for Qualifying Education Hours. Failure to attend 100% of the scheduled class time
will result in denial of any CEH for the class. The instructor will make the final determination on
attendance.

5. The deadline for registering is Friday, July 23, 2010. Attempting to register after the deadline may limit
your class options substantially. General questions can be directed to any of the board members. Contact
information can be found at www.cata-log.org under “Conferences.”

6. Inadequate interest in any class may result in the cancellation of that class. If this should happen, you
may be contacted to select another class offering.

*ATTENTION **
CANCELLATION POLICY

Cancellations of any classes from 30-10 days prior to the conference are subject to a 50% cancellation fee.
Cancellations from 10 days prior to the conference date are subject to no refund.



Rural Structure Valuation (7 CEH)

» Rural Structures Policies, Procedures, and Definitions
» Classifications and Valuation of Rural Structures

Oil & Gas Equipment Valuation (No CEH)

» Analysis and Use of BEL’s

» Valuation of Installed Equipment

» Valuation of Stored Equipment

Time Trending (7 CEH) Calculator Required
» Introduction to Statistics

» SBOE Statistical Requirements

» Time Trending Techniques

Hotel/Motel Valuation (7 CEH)
> Cost Approach
>  Market Approach
> Income Approach
» Business Value In A Hotel

Environmental Properties (7 CEH)
Public & Market Reaction

Acts, Agencies, Regulations, Courts and Organizations
Geologic Hazards and Environmental Risk
Stigma

Property Inspection

Sales Confirmation (7 CEH)

» Statutory Requirements — Sales Confirmation
» Court Case Discussion

» Title Conveyance

» Sales Confirmation Data — Implementation
Vacant Land Valuation (7 CEH)

» Land Valuation & The Appraisal Process

» Highest & Best Use

VVVVYV

> Aiiroaches To Value » Reconciliation

Personal Property (NO CEH)
Constitutional Provisions and Statutory References
Assessment Calendar

Court Decisions

Discovery and Listing

Administrative Issues: Confidentiality and Penalties
Classification

Statistics (15 CEH) Calculator Required
STATISTICS-

VVVVYVYVY

TIME TRENDING

> Slide Show
» Work Problems

» Valuation Steps
» Valuation Grids

**Class size is limited to 18**
» Basic Time Trending Analysis
» Performance Evaluation Analysis
» Case Study

> Return on and of Personal Property
> Development of Capitalization Rates
» Classification of Extended-Stay Hotels

» Environmental Site Assessments

» Appraisal Procedures

» Terminology

> Emphasis on Methamphetamine Labs

» Sales Confirmation Data-Management
» Preliminary Sales Ratio Analysis

» Final Data Analysis

» Special Issues

»  Adjustment For Time
»  Adjustment For Differing Property Characteristics

» Depreciation Tables and Factors
» Valuation Procedures
» Taxpayer Remedies and BIAs
»  Special Issues
» Performance Analysis
» Case Study
**Class size is limited to 18**
PERFORMANCE ANALYSIS

> Purpose of Statistics > Importance of Time > Spotting Outliers
> Basic Assessment Statistics Trending > Useful Statistics
> Auditor/SBOE Statistical Requirements > Required Data > Required Data
> Manual Statistical Calc. & Problems > Required Format > Required Format
COMPUTER LAB > Data Tricks and Traps > Auditor/SBOE Statistical
> Basic Statistics Using SPSS 11.0 > Basic Time Trending Requirements
> General Data Manipulation Analysis > Data Tricks and Traps
> Computer Hands-on Case > Utilizing SPSS 11.0 for
Study Performance Analysis
> Computer Hands-on Case Study



Bed & Breakfast Valuation (4 CEH)

» History and Definitions

» Statutory References

» Classification

» Three Approaches to Value

Property Measurement (4 CEH)

» Area measurement for single family residential, multi-family » ANSI Standard for residential properties
residential and commercial properties > BOMA Standard for commercial properties

> Gross Livini Area and Room Count for residential iroierties

Basic Title Conveyance (7 CEH)

Allocation of Actual Land Value
Allocation of Actual Improvements Value
Reconciliation and Assessed Value
Personal Property Issues

VVVY

» Basic Title Transfer Issues » Types of Conveyance Documents

» Elements of a Deed » Decedents’ Deeds

> The Bundle of Rights » Assessor’s Role in Keeping Ownership Records
>  Types of Ownership » Assessor’s Transfer Process

DPT % Day Administrative Courses

Abatements (NO CEH)

» Due Process »  Abatement Hearings

» Purpose of Abatements » Review by property Tax Administrator
» Clerical Errors, Erroneous Assessments, Overvaluation issues > Abatement Statutes

> Abatement Situations » Case Law

Outside Provider Courses

Deane Wilson - American Society of Appraisers (ASA)

Adjustments- The Good, The Bad, and The Ugly (7.5 CEH)

Adjustments are the least discussed element of appraising in educational offerings. Yet, adjustments are typically the most discussed by
readers of your report. Most appraisal courses do not teach the level of detail needed to understand and correctly apply adjustments. This
seminar is solely devoted to the adjustment process

This seminar is designed for the beginning appraiser as well as more experienced appraisers. Adjustments are looked at from all aspects
including why, how, when, and when not to adjust. All of the adjustment techniques are discussed and applied through class exercises.
Case studies include residential and commercial properties. This course covers the logic and critical thinking skills needed to convey
sound conclusion and write more convincing reports. A brief look at English as a second language and deeper insight into: problem
solving: decision theory: argument analysis: deductive reasoning: inductive reasoning: rhetoric versus reasoning: and much more! This is
a seminar that teaches not just improved writing skills, but improved thinking. By learning the skill of appropriate precision and the art
of making sense, appraisers can better defend their conclusions, their readers will have fewer questions, and their conclusions will have
fewer challenges.

Going Concern Valuation (7.5 CEH)

Going Concern Valuation is for real estate appraisers, lenders, assessors, and eminent domain professionals. It is a hands-on seminar that
synthesizes the latest thinking and methodologies for valuing properties that are integrated with a Going Concern. The course presents the
topic from its historical perspective through the current situation. The notion of Going Concern value is offered from several viewpoints
including the appraisers' considerations, the lenders concerns, assessors' perception, and it addresses the issue from the eminent domain
professionals' interest in the light of Kelo v. New London. The course shows how the various elements of a going concern affect each of
these professions and assists the professional in comprehending this intricate idea.

Author and Developer: L. Deane Wilson, ASA is the instructor and developer of this course as well as the other courses. Mr. Wilson has
taught every level of appraisal course both nationally and internationally. He has authored and developed many appraisal courses and
seminars, spoken at major appraisal conferences, as well written numerous articles on appraisal issues. He is the founder of the Blackwell
Institute for the Study of Land Use Ethics, and a Partner and Chief Appraiser of The Blackwell Group. He graduated from BIOLA
University with a Bachelor of Science degree in Organizational Leadership, and has a Special Major Masters Degree from California
State University, Sacramento, in Land Use Ethics.

James Felt



Colorado Water Law - James G. Felt

» The Riparian Doctrine Change of Water Right Reservoirs
» The Hydrologic Cycle Water Augmentation Plan Colorado Water Conservation Board
» The Appropriation Doctrine Water Right Administration (CWCB)

Wells

River Compacts
Reserved Water Rights
Denver Basin Rules
Ditches and Ditch Rights
Springs

Conveyance of Water Rights

Buying and Selling of Water Rights
Contract Considerations

Water Rights Appraisals

Geothermal Resources

Colorado Ground Water Commission

» Perfecting a Colorado Water Right
» Characteristics of the Appropriation
Doctrine

» Duty of Water

» “Zoning” of a water right

» Waste

VVVVVYVYVVY
VVVVVY VY

Colorado Water Law I (7.5 CEH)
The above listed content is designed as a two-day course but according to the instructor can be condensed into a one-day class that omits
much detail and gives a general exposure to the subject matter.

Colorado Water Law Il (7.5 CEH)
The above listed content is designed to be presented as a two-day course with in depth information on appraising water rights and
considerations to be addressed and considered in water law.

James C. Canestaro

Evaluating Commercial Construction (2 Day) (15 CEH)
Evaluating Commercial construction presents how light industrial, office and retail buildings are assembled and then may deteriorate over
time. More than 1,250 construction slides and a 150-page Reference Manual illustrate site improvements, structure, envelope, interior,
and environmental system components of a commercial building and how these elements can affect value.
These seminal offers you critical skills necessary to better describe, analyze, and value commercial property. Once you have taken this
program, you will better identify building characteristics, conditions, and deficiencies; succinctly describe what you see in a property
assessment report; and then factor your insights into the replacement cost, income capitalization, and market comparable calculations.
Participants have highly praised the seminar for its useful content and relevance to commercial real estate assessment.
The educational objectives of this unique two-day program are to:

> Present prevailing commercial construction techniques with associated terminology;

> Display the typical combinations or commercial construction assembles and systems;

> Illustrate where to look for potential physical deficiencies that may be hidden from view; and

> Enhance the seminar participants’ confidence to ask articulate construction related questions as part of future due diligence

inquiries.

These are all critical concerns to assessors, who deal with the valuation of commercial or high-rise multifamily residential properties. If
you want to improve your observation, description, and valuation skills, then this course is for you.

Test Optional for 15.5 QEH

Evaluating Residential Construction (1 Day) (7.5 CEH)

Evaluating Residential Construction shows how single-family houses are constructed from the ground up. More than 950 construction
slides and a 120-page Reference Manual illustrate site conditions, structure, envelope, interior, and environmental system components for
houses ranging from custom to affordable and even double-wides.
This seminar will improve your confidence to describe, analyze and value new or existing residential property. You will better identify
and characterize the quality and condition of a house that affect its market appeal and probable value. Participants have given this
seminar high mark for its practicality and benefit to real estate assessors.
The educational objectives of this information-packed one-day program are to:

>  Present prevailing residential construction techniques with associated terminology;

> ldentify diverse levels of single family housing construction quality; and

> Illustrate where to look for potential physical deficiencies in a house.
Don’t miss this seminar, if you desire to be more adept at observing the condition, identifying the quality, and determining the value of
single-family residential units.

APEX
Mobile Technology for the Real Estate Professional (1/2 Day) (NO CEH)
WHAT’S AVAILABLE WHAT’S HOT & WHAT’S NOT HOW TO
>  Mobile Computing Hardware > Mobile Computing Solutions > Measure in the Field
Solutions > Measuring Solutions >  Sketch in the Field
> Mobile Sketching Software vs. Manual >  Tips for finding the right hardware
Solutions to suit your needs

> Measuring Hardware Solutions

Kaplan Professional Schools



Site Valuation & the Cost Approach (2-Day) (15 QEH)

This class is one of the courses needed to meet the 75 hour licensed appraiser upgrade education requirement under the new 2008 AQB
licensing guidelines. Each of the required courses may be taken in any order. This course starts the discussion about land, geographic
characteristics, and neighborhoods. After the terminology is introduced, the valuation techniques are taught, including: sales comparison
method; allocation method; extraction or abstraction method; subdivision method; ground rent capitalization method; land residual
method, and the cost approach. The course will use case studies to help explain which method might work best in each situation. Included
in the textbook is an appendix reviewing appraisal math, calculating area correctly, statistics, and financial math.

Tested Course — Calculator Required

Data Analysis in a Declining Market (8 CEH)

Being able to defend your market analysis and appraisal values has never been more important or challenging. Today’s real estate market
headlines shout the news of declining real estate values, record foreclosures, and increased scrutiny of the quality of real property
appraisals. It has never been more important for appraisers to support and defend each market analysis and appraisal value. You’ll learn
the new analysis reporting requirements for declining markets recently instituted by Fannie Mae and Freddie Mac. You’ll learn how to
collect and assemble the right data and apply it to spreadsheets. And, through examples and exercises, you’ll cover step by step the
procedures for reporting supportable data analysis for your appraisal assignments.

Appraising Green Properties (1/2 day) (4 CEH)

Understand how the emerging market trend toward sustainability impacts residential real estate appraisals. An appraisers’ ability to
provide accurate appraisals is increasingly dependent on how well they can identify green elements and incorporate them into appraisal
reports. Discover why the inclusion of sustainable elements is no longer the exception in residential building, and learn how to identify
and quantify these elements in your appraisals.  In this course, you’ll see why there’s more to green than meets the eye. From a primer
on energy-efficient and energy-improvement mortgages, to a cost analysis of green versus traditional building and everything in between
newer and veteran appraisers alike will find this course vital to their business. Sustainability is the future of residential construction, so
you don’t want to miss this class!

International Association of Assessing Officers (IAAO)
Depreciation Analysis (2-day) (15 CEH)
Depreciation Analysis provides a comprehensive, advanced treatment of the techniques of estimating depreciation of residential property.
Through a series of market oriented case studies and demonstration problems, types of depreciation and generally recognized methods for
measuring depreciation are covered, with emphasis on the observed condition method. Depreciation measurements are applied to a single
subject property, providing experience in analyzing the advantages and limitations of each method.
Tested Course — Calculator Required **Credit hours will go toward IAAQO designation**

American Society of Farm Manager & Rural Appraiser (ASFMRA)

Income Approach Applications (7 CEH)

This 1-day seminar presents advanced techniques and Discounted Cash Flow (DCF) analysis, including the discussion of Net Present
Value and Internal Rate of Return. Most of the seminar will be devoted to discussing the rationale behind the various valuation methods
and procedures. Students will review basic definitions, analyze a lease document to determine which rights have been leased and study
the various lease types. Terms of the lease will be discussed, as will the distinctions in evaluating the leased fee interests and the
leasehold estate interests.

Appraising Agricultural Land in Transition (7 CEH)

This 1-day seminar explores new uses of the land including wildlife and waterfowl! production areas, wildlife and waterfowl habitat areas,
public and private hunting preserves, fish production areas and recreational use for hunting, fishing and trophy ranches. The student will
explore national trends and work with case studies that assist appraisers, review appraisers and managers in dealing with valuation issues
pertaining to land in transition.

M. Steven Kane
Appraisal Valuation Modeling (AVM) (7 CEH)

Examples of Modeling/Statistics Used Now Differences Between Assessment and Analyzing Your Data - Quantity
e Appraisal As A Valuation Model "AVM" Modeling Data Analysis Tools
e Examples - Residential, Commercial,  Quick History of AVMs Applications Set |
Agricultural e Mass vs. Single Property e Time Trending
Appraisal Applications Set I
e Birth of AVMs e Modeling Basics
e Why Appraisal Valuation Regression Analysis

Modeling Review



